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Section 1.0 Description 

1.1 Introduction 

This document provides basic operating instructions for the Mission Transceiver Panel 
mount, herein subsequently referred to as the MTP. 

The MTP is highly configurable with a large set of options for both the Operator and the 
Administrator. Many of these options are outside the scope of this guide. For advanced 
configuration and operation please see the MTP136D’s product page on AEM’s 
website, www.aem-corp.com, or contact AEM Technical Support at support@aem-
corp.com. 

This guide supports firmware version 1.03. 

1.2 Description 

The MTP is a stand-alone VHF FM transceiver that is equipped with a main and guard 
radio. The MTP is capable of semi-duplex communication and features three operating 
modes: narrowband analog, wideband analog, and digital APCO P25 Phase I. 

The MTP transmit and receive frequency range is the 136 – 174 MHz VHF band with 
high (10W) or low (1W) transmit output power selectable from the front panel interface. 

Continuous Tone Code Squelch System (CTCSS) and Continuous Digital Coded 
Squelch System (CDCSS) encoding/decoding are selectable in analog mode. Network 
Access Codes (NAC) and Talk Group IDs (TGID) are available in P25 digital mode. 

The MTP is compliant to applicable equipment performance standards TIA-603-E, TIA-
102 and DO-160G environmental standards. 

 

Figure 1: MTP136D-000GN 
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1.3 General Statements 

1.3.1 Warnings 

WARNING 

High volume settings can cause hearing damage.  
Set the headset volume control to the minimum volume setting prior to 

conducting tests, and slowly increase the headset volume to a comfortable 
listening level. 

1.3.2 Controlling Your Exposure to RF Energy  

RF is a form of electromagnetic energy (as is sunlight), and there are recommended 
levels of maximum RF exposure. To control your exposure to RF and comply with the 
maximum exposure limits for occupational/controlled environments, follow these 
guidelines:  

1. Do not talk (transmit) on the radio more than the rated transmit duty cycle. This is 
important because the radio radiates more energy when it is transmitting than when 
it is receiving.  

2. While you are transmitting (talking or sending data) on the radio, you must ensure 
that there is always a distance of 45.3 inches (1.15 m) between people and the 
antenna. This is the minimum safe distance.  

3. Use the radio only with approved antennas and attachments and make only 
authorized modifications to the antenna otherwise you could damage the radio and 
violate FCC regulations.  

For more information on what RF energy is and how to control your exposure to it, visit 
the FCC website at www.fcc.gov/oet/rfsafety/rf-faqs.html. 

1.3.3 Regulatory and Compliance Statements 

Reference the Installation Manual (MTP136D-000GN-815-0) for additional ISED and 
FCC regulatory and compliance statements. 

1.3.4 Warranty 

Please refer to the standard product warranty conditions available on our website, 
www.aem-corp.com. 

1.4 Limitations 

Front Panel USB is for maintenance activities only and is not intended for use during 
flight. USB port door is to be closed. 
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1.5 Part Number Nomenclature 

The product part number is defined as follows: 

M T P 1 3 6 D - 0 0 0 G N 
          

Figure 2: Part Number Nomenclature 

Item Name Description 

 
Product Family MTP: Mission Transceiver Panel Mount 

 

Start Frequency  
(in MHz) 

136: 136 MHz 
138: 138 MHz 

 
Feature Character D: Digital capable 

Blank: Analog only 

 

Derivative Identifier 
[000-999] 

000: Base product 

 

Feature Character 
 

G: Guard receiver installed 
Blank: No guard 

 
Feature Character N: NVIS compliant lighting 

Blank: Non-NVIS lighting 

Table 1 :Unit Nomenclature 

 

End of Section 1.0 Description

1 2 3 4 5 6 
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Section 2.0 Operation 

2.1 Introduction 

The MTP is controlled using the front panel mounted keypad, knobs, and switches. 
The display is navigated using the front panel controls to select from menus. 

2.2 Front Panel 

 

Figure 3: Front Panel 

Item Name Description 

 

Main Volume Knob 
(MAIN VOL) 

Adjusts the volume of the main radio. Detent turns the 
MTP OFF. 

 

Monitor 
(MON) 

Bypasses Squelch Threshold and Channel Signaling 
allowing all transmissions to be heard. 

 

Channel Recall 
(RCL) 

Returns to the previous channel. 

 

Radio Select 
(MAIN GUARD) 

Changes the Focused Radio. 

 

Transmit Power 
(HI LO) 

Changes transmit power. 

 

Guard Volume Knob 
(GUARD VOL) 

Adjusts the volume of the guard radio. 

 

Rotary Selector 
(PUSH | ENTER) 

Changes channel, navigates, and modifies options. 

 

Keypad and MENU Shows/hides the Menu. Changes channel, navigates, and 
modifies options. 

 

Data Port 
(DATA) 

USB Type-C port used for Profile Import/Export, Error Log 
Export, and Firmware Updates. 

Table 2: Front Panel Controls 

2 

3 

4 

7 

6 

8 

9 

1 
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2.3 J1 System Interface Connector 

See the Installation Manual for more information. 

Input Functionality 
PANEL LIGHTING Panel and display dimming. 
CHAN/SELECT + Equivalent to rotary selector clockwise. Changes channel, 

navigates, and modifies options. Commonly installed on the 
airframe’s cyclic stick 

CHAN/SELECT - Equivalent to rotary selector counterclockwise. Changes 
channel, navigates, and modifies options. Commonly installed 
on the airframe’s cyclic stick. 

MIC KEY IN PTT (Push To Talk). 

Table 3: System Interface Connector Inputs 

2.4 Power On 

To power on, rotate MAIN VOL clockwise past the detent. The display will briefly 
show a splash screen including the AEM logo, the firmware version, and the model 
number. Once initialization is complete, the display will show the Home Screen. 

2.5 Home Screen 

The Home Screen shows each radio’s indicators, Active Channel, and Active Zone. 
One radio is Focused (expanded) while all others are Unfocused (collapsed). 

All navigation within this guide begins from the Home Screen. 

       

Figure 4: Main Radio Focused                      Figure 5: Guard Radio Focused 
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2.5.1 Focused Radio 

Transmit, receive, and channel changes occur on the Focused Radio. 

 

 

 

Figure 6: Focused Radio 

 
Item Description 

 

Channel modulation. 
N: Narrowband Analog, 12.5kHz bandwidth. 
W: Wideband Analog, 25kHz bandwidth. Requires Wideband Key installed. 
D: P25 Phase 1 Digital. Requires digital variant. 

 

Radio name. 

 

Channel number. 

 

Channel name. 

 

Receive frequency. 

 

Zone name. 

 

Scan priority enrolment. Configured per zone. Scanned under P, L+P, and Z+P 
scan algorithms. 

 

Receive Channel Signaling. CTCSS, CDCSS, NAC, or TGID. “0x” prefix refers 
to hexadecimal display format. 

 

Transmit Channel Signaling. CTCSS, CDCSS, NAC, or TGID. “0x” prefix refers 
to hexadecimal display format. 

 

Transmit frequency. 

 
Indicators. 

 

Scan list enrolment. Scanned under L and L+P scan algorithms. 

Table 4: Focused Radio Elements 

3 

11 

1 

2 4 5 6 
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2.5.2 Unfocused Radio 

Unfocused radios can receive but cannot transmit. 

 

 

 

Figure 7: Unfocused Radio 

Item Description 

 

Indicators. 

 

Channel name. 

Table 5: Unfocused Radio Elements 

2.5.3 Indicators 

Indicators show the receive and transmit status of each radio. 

Indicator Description 

   

Highlights when a carrier is detected on the receive 
frequency. 

 

   

Highlights when Squelch Threshold and Channel 
Signaling has been met allowing audio to be 
delivered to the headset. 

   

Highlights when transmitting. 

   

Highlights when transmit power is set to High. 
Highlighting can be disabled by setting the 
“Highlight HI Power” user option to Off. 

Table 6: Home Screen Indicators 

  

1 

2 
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2.5.4 Simplex 

When TX channel options match the RX channel options, the TX options may be 
hidden by Auto Simplex (Figure 8). This can be changed on the User Options 
Screen. 

1. MENU > More > Options 

2. Choose Auto Simplex 

• On: TX information hidden when same as RX.  

• Off: TX information always shown. 

 

Figure 8: Auto Simplex Hiding TX Options 
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2.6 Menu 

The menu provides access to navigation and common actions. It can be opened at 
any time by pressing the MENU button. When open, it is overlayed on the right side 
of the display. The content depends on the currently available options and screens. 

An action is triggered by pressing the associated number on the keypad. 

Some actions have consistent numbering across all screens such as Bright (0), 
Save (7), Back (7), and Cancel (8). 

                                     

Figure 9: Example Menus 

2.7 Active Channel 

Radios use one channel at a time known as the Active Channel. The Active Channel 
dictates receive and transmit behavior of the radio. The Active Channel on the 
Focused Radio can be changed on the Home Screen by turning the rotary selector 
or by entering the channel number using the keypad. 

2.8 Active Zone 

Radios use one zone at a time known as the Active Zone. The Active Zone dictates 
available channels to the radio and modifies behavior according to the contained 
options (priority scan channels, active signal lists, and permissions). The Active 
Zone can be changed on the Home Screen. 

1. MENU > Zone. 

2. Choose a zone. 

Changing the Active Zone may be locked by an Administrator on a per-radio basis. 
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2.9 Transmit 

Transmit will begin on the Active Channel of the Focused Radio when PTT is active. 
Receive is not possible when transmitting. Transmit can occur with two power 
levels, Low (1W) and High (10W), and can be changed using the HI/LO button. 

Transmit may timeout after a period defined by an Administrator. This is indicated by 
an exclamation mark on the transmit indicator (TX!) and can be cleared by re-
transmitting. 

2.10 Transmit DTMF Tones 

DTMF tones can only be sent while transmitting on an Analog channel. 0-9 is sent 
from the keypad and A-D, #, * from the Menu (Figure 10). 

Transmitting DTMF tones may be disabled by an Administrator. 

 

Figure 10: DTMF Tone Menu 
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2.11 Channel Signaling Display Format 

The numerical display format for Tones (CTCSS), NAC, and TGID Channel 
Signaling can be changed using the Format Menu. This menu will only show format 
options for the currently applicable Channel Signaling. The Format Menu is 
accessible on the Home Screen. See Table 7 for a list of all display format options. 

1. MENU > Format. 

                             

Figure 11: Example Format Menus 

 
 

Display Format Description Applicable Signaling Example 
Hexadecimal Base 16 with a prefix of “0x”. NAC and TGID 0x293 

Decimal Base 10 whole number. NAC and TGID 157 
Frequency Base 10 with 1 decimal place. Tone 82.5 

MCode Motorola coded. Tone YZ 
WCode Wolfsberg coded. Tone 06 

Table 7: Display Format Options 
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2.12 LCD Brightness 

The LCD brightness can be adjusted on the Brightness Screen accessible from 
most screens. 

1. MENU > Bright. 

 

 

Figure 12: Brightness Screen 

Item Description 

 

Brightness adjustment. 

 

Dimming due to panel lighting input. 

 

Combined LCD brightness. 

 

Displayed when a value has reached it’s minimum or maximum value. 

Table 8: Brightness Screen Elements 

  

2 

1 

3 
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2.13 LCD Brightness Mode 

LCD Brightness Mode can be changed on the Brightness Screen Menu. 

1. MENU > Bright. 

2. MENU > Choose LCD Mode. 

• Day: Maximum brightness is not limited allowing the LCD to reach its 
highest possible brightness. 

• Night: Maximum brightness is limited for use in Night or NVIS 
applications. Dimming from panel lighting input is customizable by an 
Administrator. 

• Auto: Day or Night automatically chosen based on panel lighting input 
voltage. Customizable by an Administrator. 

 

Figure 13: Changing LCD Mode on the Brightness Screen 

2.14 Receive Volume Range 

Minimum and maximum receive volume can be configured per radio on the User 
Options Screen. The volume knobs are automatically rescaled to the configured 
range. For example, setting the minimum volume to 20% will result in 20% volume 
when the volume knob is fully counterclockwise. 

1. MENU > More > Options. 

2. Scroll to desired radio section (Main or Guard). 

3. Choose Min Volume or Max Volume. 
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2.15 Microphone Sidetone Volume 

Microphone sidetone volume can be changed on the Radio Options Screen. 

1. MENU > Radio. 

2. Scroll to Audio section. 

3. Choose Sidetone Vol. 

2.16 DTMF Sidetone Volume 

DTMF sidetone volume can be changed independently of the microphone sidetone 
volume on the Radio Options Screen. 

1. MENU > Radio. 

2. Scroll to Audio section. 

3. Choose DTMF Sidetone Vol. 

2.17 Squelch Threshold 

Squelch threshold defines the required signal strength above noise to break 
squelch. Can be changed per radio on the Radio Options Screen. 

1. MENU > Radio. 

2. Scroll to desired radio section (Main or Guard). 

3. Choose Sq. Threshold. 

• Low: Low strength signals will break squelch. Recommended when 
operating across large distances, or where RF activity is minimal. 

• Medium: Medium strength signals will break squelch. Recommended 
setting for urban and semi-urban environments where moderate RF 
activity is expected. 

• High: High strength signals are required to break squelch. Recommended 
in environments where high RF activity is expected. 

2.18 Monitor Latch 

The persistence of Monitor when using the Monitor button can be changed on the 
User Options Screen. 

1. MENU > More > Options. 

2. Choose Monitor Latch. 

• Hold: Long press to latch monitor. 

• On: Short press latches monitor. 

• Off: Monitor never latches. 
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2.19 Digital Monitor 

Digital monitor defines the monitor behavior on all digital channels. It can be 
changed on the User Options Screen. 

1. MENU > More > Options. 

2. Choose Digital Monitor. 

• All: Monitors all NACs and TGIDs. 

• TGID: Monitors all NACs within the current TGID. Indicated on Home 
Screen by overlaying current NAC with 0xF7E (All) while monitoring. 

2.20 Auto TX Power 

Auto TX Power modifies what happens when the HI/LO button is pressed. It can be 
changed on the User Options Screen. 

1. MENU > More > Options. 

2. Choose Auto TX Power. 

• On: Radio TX power is set to the per-channel stored TX Power option on 
channel changes and startup. Pressing HI/LO will temporarily override the 
TX power until the next channel change or power cycle. 

• Off: Radio TX power persists across channel changes and power cycle. 
Pressing HI/LO will toggle and immediately save the TX power. Per-
channel TX Power is ignored. 

2.21 Go Home 

When triggered the Go Home function immediately returns to the home screen 
saving all changes on the way back. The trigger of this function can be changed on 
the User Options Screen. 

1. MENU > More > Options 

2. Choose Go Home. 

• Off: Disabled. 

• PTT: When PTT is keyed. 

• Radio Sel.: When the MAIN/GUARD button is pressed. 

• Both: Either PTT or Radio Select. 
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2.22 Scanning 

Scanning can be started and stopped from the Home Screen. 

1. MENU > Scan. 

The order of scanned channels is determined by the selected scan algorithm (Table 
9) which can be changed by turning the rotary selector while scanning. 

 

Figure 14: Scanning on the Home Screen 

Algorithm Description Example 
List 

 

Scans all channels in a zone in numerical order that have 
Channel Scan (↻) enabled. 

Home, 1, 2, 3,  
Home, 1, 2, …  

Priority 

 

Scans zone P1, zone P2, and Home in order of priority. 

When locked, the scanner will periodically check higher 
priority channels for transmissions.  

P1, P2, Home, 
P1, P2, Home,  
P1, … 

List + 
Priority 

 

A combination of List and Priority algorithms where a 
single, incrementing, list channel is scanned after all 
Priority algorithm channels are scanned. 

P1, P2, Home, 1, 
P1, P2, Home, 2, 
P1, P2, … 

Zone 

 

Scans all channels in the Active Zone. 1, 2, 3, 4,  
1, 2, … 

Zone + 
Priority 

 

A combination of Zone and Priority algorithms where a 
single, incrementing zone channel is scanned after all 
Priority Algorithm channels are scanned. 

P1, P2, Home, 1, 
P1, P2, Home, 2, 
P1, P2, … 

Table 9: Scan Algorithms  
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2.22.1 Scan Locked 

If a signal is detected while scanning, the radio will lock to that channel to allow the 
transmission to be heard and responded to. When locked, the Home Screen Action 
Menu is modified with the following options: 

1. Radio: Navigates to the Radio Options screen. 

2. Scan: Stop scanning and return to the home channel. 

3. Next: Skip this channel and continue scanning. 

4. Stay: Stop scanning but return to the locked channel instead of home. 

5. Delete: Temporarily remove the locked channel from the scan list. Channel 
won’t be scanned again until scan is re-enabled. 

Pressing PTT will transmit on the locked channel. Scan will continue after a short 
period of RX or TX inactivity. 

 

 

Figure 15: Scan Locked on the Home Screen 
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2.23 Profiles 

Options and lists are stored in a JSON file (.json) called a Profile. Only one Profile is 
stored and used at a time. 

2.23.1 Create a Profile 

Profiles can be created using the AEM Radio Profile Editor found on AEM’s website 
www.aem-corp.com on the MTP136D product page under software. 

2.23.2 Import a Profile 

Profiles can be imported from a USB storage device connected to the DATA port. 

1. Copy profile into the root directory of the USB device. 

2. MENU > More > Import. 

3. Connect the USB device to the DATA port. 

4. Select the desired profile from the list. 

5. Press MENU and choose what to import from the selected profile: 
1. All: Imports entire profile including all Options and Lists. 
2. Options: Imports only options. 
3. Lists: Imports zones, channels, tones, codes, TGIDs, and NACs. 

6. Wait until one of the results in Table 10 is displayed. This may take a few 
minutes. 

Result Description 

Success. Import successful, profile saved. 
Insufficient 
permissions. 

Profile contains options that exceed current permission level. Login 
and try again. 

Incompatible version. Profile is not compatible with this firmware version. Convert using 
AEM Radio Profile Editor on AEM’s website: www.aem-corp.com 
on the MTP136D product page under software. 

Device error. USB communication issue or a device compatibility problem. Try 
again or try a different device. 

Invalid syntax or 
options. 

File likely corrupted. Replace and try again. 

Table 10: Import results 
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2.23.3 Export a Profile 

Profiles can be exported to the root directory of a USB storage device connected to 
the DATA port. 

1. MENU > More > Export. 

2. Connect a USB device to the DATA port. 

3. Enter desired file name. 

4. MENU > Export. 

5. Wait until one of the results in Table 11 is displayed. This may take a few 
minutes. 

Result Description 

Success. Export successful, profile saved to USB device. 
Device error. USB communication issue or a device compatibility problem. Try 

again or try a different device. 

Table 11: Export results 
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2.23.4 USB Drive Requirements 

The MTP136D only supports USB drives that meet the following requirements: 

1. Formatted to FAT, FAT32, or exFAT. 

2. Power consumption less than 4.5W. 

3. USB-C or connected through a USB-C adapter. 

4. Mechanical requirements as shown in Figure 16 below. 

 

 

Figure 16: USB Drive Mechanical Requirements 
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2.24 Wideband Operation (Key Required) 

To comply with FCC CFR Part 90.203, transmission of wideband channels (25 kHz) 
is disabled by default. 

To enable this feature contact AEM Technical Support at support@aem-corp.com 
with the serial number of the unit to acquire a Wideband Key. Key installation steps 
can be found in the Installation Manual. It is the responsibility of the installer or 
operator to determine if they meet the regulatory exceptions to operate with this 
feature enabled. 

2.25 Agile Operation (Key Required) 

To comply with FCC CFR Part 90.203 and ISED RSS 119, modification of zones, 
channels, and signal lists from the front panel is disabled by default.  

To enable this feature contact AEM Technical Support at support@aem-corp.com 
with the serial number of the unit to acquire an Agile Edit Key. Key installation steps 
can be found in the Installation Manual. It is the responsibility of the installer or 
operator to determine if they meet the regulatory exceptions to operate with this 
feature enabled. 
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2.25.1 Edit the Active Channel 

The Active Channel of the Focused Radio can be edited without leaving the Home 
Screen. 

1. MENU > Edit. 

• All: Choose which channel option to edit or create a new channel. 

• Name: Edit channel name. 

• RX/TX Freq: Edit channel frequency. 

• RX/TX NAC: Edit channel NAC. 

• RX/TX Tone: Edit channel tone. 

• RX/TX Code: Edit channel code. 

 

Figure 17: Edit Menu 

2.25.2 Add a Channel to the Active Zone 

A new channel can be added to the Active Zone on the Agile Edit All Screen. The 
new channel will be added to the end of the list, set as the Active Channel, and 
immediately made available for editing. 

1. MENU > Edit > All. 

2. MENU > New. 
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2.25.3 Edit a Zone 

Zones can be edited on the Zone Edit Screen. 

1. MENU > More > Lists > Zone. 

2. Choose a zone. 

3. Choose an option. 

2.25.4 Add a Channel to a Zone 

Channels can be added on the Channel Select Screen. 

1. MENU > More > Lists > Zone. 

2. Choose a zone. 

3. MENU > Channels. 

4. MENU > Insert. 

5. Choose the destination. 

2.25.5 Edit a Channel in a Zone 

Channels can be edited on the Channel Edit Screen. 

1. MENU > More > Lists > Zone. 

2. Choose a zone. 

3. MENU > Channels. 

4. Choose a channel. 

5. Choose an option. 

2.25.6 Edit a Signal List 

Signal lists can be edited on the Tone, Code, NAC, or TGID List Edit Screen. 

1. MENU > More > Lists > Tone, Code, NAC or TGID. 

2. Choose a signal list. 

3. Choose an option. 
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2.25.7 Edit a Signal in a Signal List 

Signals can be edited on the Tone, Code, NAC, or TGID Edit Screen. 

1. MENU > More > Lists > Tone, Code, NAC or TGID. 

2. Choose a signal list. 

3. MENU > Tones, Codes, NACs or TGIDs. 

4. Choose a signal. 

5. Choose an option. 

2.25.8 Edit with Auto Simplex 

When TX channel options match the RX channel options any changes to RX options 
will be also applied to the TX options. This is indicated by a bar on the Home Screen 
while editing the Active Channel (Figure 18). Modifying any of the TX options unlinks 
the RX and TX options. This can be changed on the User Options Screen. 

1. MENU > More > Options 

2. Choose Auto Simplex 

• On: Changes to RX options applies to TX options when they are the same.  

• Off: Changes to RX options do not modify TX options. 

 

 

Figure 18: Auto Simplex Link Bar 
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2.26 Supported Channel Signaling (CTCSS, CDCSS, NAC, TGID) 

FREQ MCODE WCODE FREQ MCODE WCODE FREQ MCODE WCODE 
67.0 XZ 1 118.8 2B 21 183.5 N/A2 56 
69.3 WZ 51 123.0 3Z 22 186.2 7Z 36 
71.9 XA 2 127.3 3A 23 189.9 N/A2 57 
74.4 WA 3 131.8 3B 24 192.8 7A 37 
77.0 XB 4 136.5 4Z 25 196.6 N/A2 58 
79.7 WB1 5 141.3 4A 26 199.5 N/A2 61 
82.5 YZ 6 146.2 4B 27 203.5 M1 38 
85.4 YA 7 151.4 5Z 28 206.5 8Z 62 
88.5 YB 8 156.7 5A 31 210.7 M2 41 
91.5 ZZ 11 159.8 N/A2 52 218.1 M3 42 
94.8 ZA 12 162.2 5B 32 225.7 M4 43 
97.4 ZB 13 165.5 N/A2 53 229.1 9Z 47 

100.0 1Z 14 167.9 6Z 33 233.6 M5 44 
103.5 1A 15 171.3 N/A2 54 241.8 M6 45 
107.2 1B 16 173.8 6A 34 250.3 M7 46 
110.9 2Z 17 177.3 N/A2 55 254.1 0Z 63 
114.8 2A 18 179.9 6B 35    

Table 12: Supported CTCSS Tones 

 
CDCSS Codes 

0nn 1nn 2nn 3nn 4nn 5nn 6nn 7nn 
017 114 205 306 411 503 606 703 
023 115 212 311 412 506 612 712 
025 116 223 315 413 516 624 723 
026 122 225 325 423 523 627 731 
031 125 226 331 431 526 631 732 
032 131 243 332 432 532 632 734 
036 132 244 343 445 546 654 743 
043 134 245 346 446 565 662 754 
047 143 246 351 452  664  
050 145 251 356 454    
051 152 252 364 455    
053 155 255 365 462    
054 156 261 371 464    
065 162 263  465    
071 165 265  466    
072 172 266      
073 174 271      
074  274      

Table 13: Supported CDCSS Codes 

  

 
1 Alternative MCODE SP not supported. 
2 No MCODE assigned to this CTCSS tone. Will remain displayed in frequency format when 
format is set to MCODE. 
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NAC Description 
0x000 
to 
0xFFF 

General purpose. 

0x293 Default NAC commonly used on interoperability channels and ham radio 
equipment. 

0xF7E Receive all. RX only, not supported on TX. 
0xF7F Not supported. Reserved by P25 standard. 

Table 14: Supported NACs 

 
TGID Description 

0x0001 
to 
0xFFFE 

General purpose. Enables P25 Selective mode. 

 
-- Receive all. RX only, not supported on TX. Enables P25 Normal mode. 
0xFFFF Transmit all. Will bypass any TGID setting on any other receiver on the same 

frequency and NAC. 

Table 15: Supported TGIDs 
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2.27 Troubleshooting 

If a problem persists or a serious problem occurs, discontinue use, and contact AEM 
Technical Support at support@aem-corp.com. 

Problem Solution 
Unable to edit channels, 
zones, signal lists, or 
signals. 

Administrator has restricted the ability to make changes using 
permissions or the Agile Edit Key. Contact Administrator or 
AEM. 

Cannot hear sidetone. Ensure Sidetone is enabled, and Sidetone Volume is 
sufficiently high (Radio Options Screen). 

Poor audio quality. Refer to the Installation Manual to verify installation. If issue 
persists, contact AEM. 

Unable to transmit. • Transmit timeout may have been reached (indicated by TX!). 
Re-key PTT. 

• Ensure Active Channel is not disabled. 

Transmit power overridden 
to low (LO!). 

Radio is overheating. Refer to the Installation Manual to verify 
installation. Ensure it is not installed close to high heat emitting 
equipment. If issue persists, contact AEM. 

Hearing static or adjacent 
channel communication. 

• Increase Squelch Threshold. 
• Confirm channel modulation is correctly configured. 

Unable to hear a received 
signal. 

• Increase volume. 
• Use Monitor to test whether squelch sensitivity or incorrect 

Channel Signaling is the cause of the problem. 
• Reduce Squelch Threshold. 

Unable to use wideband 
modulation. 

Wideband Key not installed. Contact Administrator or AEM. 

Radio Fault. Contact AEM. 
CRC failure. Contact AEM. 
Unexpected restart. Contact AEM. 

Table 16: Troubleshooting 

 
 
 

End of Section 2.0 Operation 
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AEM MANUAL REVISIONS 

 
§ Rev. # Revision Description Date 

2.20, 
2.22, 

2.22.1, 

2.23.3 

2.5.1 

1.02 General improvements. 03-Jul-2025 

2.23.4 1.02 Added USB drive requirements. 03-Jul-2025 

2.5.3, 

2.23.2, 

2.25.1, 

2.25.2. 

1.02 
Updated to support new and changed behavior in 
software rev 1.03. 

03-Jul-2025 

All 1.01 Changed all references of MTP136D to MTP. 07-Feb-2025 

2.12 1.01 
Changed section name Display Brightness to LCD 
Brightness.  

07-Feb-2025 

1.1, 

2.12, 

2.13, 

2.14, 

2.19.2, 

2.19.3. 

1.01 
Updated to support new and changed behavior in 
software rev 1.02. 

07-Feb-2025 

1.5 1.01 Updated part number nomenclature. 07-Feb-2025 

2.11 1.01 Added table to explain all Display Format options. 07-Feb-2025 

2.18, 
2.20, 
2.21. 

1.01 
Added descriptions for Monitor Latch, Auto TX 
power, and Go Home features. 

07-Feb-2025 

All 1.00 Initial release 16-Apr-2024 
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